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On the occasion of the exhibitions Frank Lloyd Wright: 
From Within Outward and Learning By Doing, the 
Guggenheim and Google SketchUp invite amateur and 
professional designers from around the world to enter 
Design It: Shelter Competition. From now until August 23, 
you can submit a 3-D shelter for locations around the world 
using Google SketchUp and Google Earth.

Why shelters?
The competition is an extension of Learning By Doing, an 
exhibition in the Guggenheim Museum Sackler Center 
for Arts Education that features plans, photographs, and 
models of student-built shelters from the Frank Lloyd 
Wright School of Architecture. For the past seven decades, 
students at this school have taken on the challenge of 
designing, building, and living in small shelters nestled 
in the landscapes of the school’s Arizona and Wisconsin 
campuses. In working on these shelters, students consider 
human needs for safety and comfort, as well as the 
relationship between architecture and place.

Design It: Shelter Competition opens up the project to 
you. If you could build a shelter anywhere in the world, 
where would it be? How would you design it to respond  
to the surrounding environment?

Key Dates and Deadlines
Submission period:  
	 June 8—August 23, 2009 
Ten People’s Prize finalists selected:  
	 September 7, 2009 
People’s Prize public voting period:  
	 September 7—October 10, 2009 
People’s Prize and Juried Prize winners announced: 		
	 October 21, 2009

Accept the Challenge
Find out more about how to enter the competition.

competition guidelines
In celebration of the ideas and teaching of Frank Lloyd 
Wright, the Guggenheim Museum invites you to create 
your own virtual shelters, located anywhere on Earth. 
Share your design on the Guggenheim’s Web site by first 
modeling your shelter with Google SketchUp, then placing 
your model on Google Earth.

When designing your shelter, consider Frank Lloyd Wright’s 
interest in the connection between architecture and its 
location. How can your shelter respond to the specific 
natural and built environments that surround it?

Project Specs
Location
You can build your shelter anywhere on Earth: from city 
to desert, hill to valley. You cannot remove any existing 
buildings, but you can add on to existing structures.

Size
Keep your shelter small—it can be no larger than 100 square 
feet (9.3 meters), and entire shelter no taller than 12 feet 
(3.6 meters).
Amenitites
Your shelter must offer protection from the elements and 
provide a space for one person to study and sleep. Keep it 
simple—no water, gas or electricity allowed.

How to Enter
To enter the contest, submit the following:

SketchUp model of your shelter (view the  1.	
SketchUp tutorial page for instructions).

design it: shelter competition 
Submission Guide

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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A written description (in English) of your shelter and 2.	
how it integrates into the location where you placed it 
(limited to 70 words).

SketchUp animation showing the inside and outside  of 3.	
your shelter. (The animation is optional. Keep in mind, 
though, that in Google Earth, viewers will only be able 
to see the outside of the shelter—an animation is a great 
way to present a more detailed interior view of your 
design.)

Images of your shelter (1–4 JPEGs, at least 235 pixels 4.	
wide but no larger than 720 pixels wide).

Once all your materials are ready, you must fill out the 5.	
submission form. 

submission form / tips
Complete the submission form and enter all required 
information as indicated with an asterisk below (unmarked 
items are optional). 

First Name*
Last Name*
E-mail address*
City where you reside*
Country where you reside*
Age* (Must be 13 years or older as of June 8, 2009)

Shelter Title* (Limited to 40 characters)

Shelter Description* (Limited to 70 words)

Google 3D Warehouse Model Link* 
After you’ve uploaded your SketchUp model to the 
Google 3D Warehouse, you need to tell us where it is by 
providing the web address for your model. You can find this 
by selecting the Link button at the bottom of your model’s 
page in the 3D Warehouse. Copy the long string of text 
that appears, then paste it into this submission form. How? 

Country where your shelter is located*
Upload image of your shelter* 
You can export images of your model from SketchUp to 
show specific views that you want people to see. How? 

To enter this competition, you must upload at least one 
(and up to four) images of your model. These images must 
be JPEGs, and must be at least 235 pixels wide but no 
larger than 720 pixels wide.

Upload 2nd image of your shelter 
You can export images of your model from SketchUp to 
show specific views that you want people to see. How? 

To enter this competition, you must upload at least one 
(and up to four) images of your model. These images must 
be JPEGs, and must be at least 235 pixels wide but no 
larger than 720 pixels wide.

Upload 3rd image of your shelter
Upload 4th image of your shelter
YouTube Video URL 
If you’ve created a video of your model that you’d like to 
include with your competition entry, you can upload it to 
YouTube. The YouTube Video URL is the Web address for 
your video on YouTube. You can find it on your video’s Web 
page. How do I export an animation from SketchUp? 

To enter, you must be 13 years or older as of June 8, 2009. 
All entries must be in English. In order to be eligible for a 
prize, your entry must be uploaded into the Google 3D 
Warehouse. To upload your model to the 3D Warehouse 
you must create a Google Account. Sign up for a Google 
Account.

google  sketchup Introduction  
and Overview
Google SketchUp is software that you can use to build 
virtual 3-D models of anything you like. It’s free, available 
in a number of different languages, and relatively easy to 
learn. You can download Google SketchUp and start using 
it right away.

The shelter models you submit for this competition need to 
be uploaded from Google SketchUp (where you can create 
them) to the Google 3D Warehouse. This is a huge, online 
repository of SketchUp models contributed by people all 
over the world.

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support/bin/answer.py?answer=37939&cbid=-f2y4lzm8778c&src=cb&lev=answer
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=114296
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=114296
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=114335
https://www.google.com/accounts
https://www.google.com/accounts
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To get started here’s what you need 
 to do

Download Google SketchUp and Google Earth for free. 1.	
Both are available for both Windows and Macintosh 
computers.

Use Google SketchUp to design a shelter for a 2.	
particular location on the planet. Give your model a 
precise geographic location with Google Earth.

Upload your geographically-located SketchUp shelter 3.	
to the Google 3D Warehouse.

Copy the web address for your shelter model from the 4.	
Google 3D Warehouse and paste it into the entry form 
for this competition.

Export at least one (and as many as four) views of your 5.	
model as JPEG images and upload them when you’re 
submitting your entry.

Export an animation of your shelter as a video and 6.	
upload it to YouTube, then copy and paste the YouTube 
video URL into the entry form. This is optional, but 
strongly encouraged.

Instructions for doing all of the above things are included in 
the rest of this PDF. Additional information is available in 
the Help Centers for Google SketchUp and Google Earth:

Google SketchUp Help Center

Google Earth Help Center

Downloading and installing Google 
SketchUp
Google SketchUp is software that you download onto your 
computer; it doesn’t run in a web browser like many of 
Google’s other applications.

To download Google SketchUp:

Visit http://sketchup.google.co1.	 m

Use the Download Google SketchUp button in the 2.	
upper-right corner of the page.

Use the Download Google SketchUp 7 link on the page 3.	
that appears.

Note: You can download and install the Pro version of Google SketchUp if 
you like, but the Free version is all you need to design, model and upload a 
shelter for this competition. If you download the Pro version and decide not 
to buy a license to activate it, it will revert to the functionality of the Free 
version after the trial period has elapsed.

Choose the operating system on which you’d like to run 4.	
Google SketchUp (Windows or Mac OS X).

Accept the terms of the license agreement by selecting 5.	
Agree and Download, then start the download to your 
computer.

To install Google SketchUp on your 
computer (after you’ve downloaded it)
Windows computers

Log in to the computer with a user account that has 1.	
administrator rights.

Double-click on the EXE install file that you 2.	
downloaded. On Windows Vista, right-click and select 
Run as an administrator.

Select Next in the Welcome dialog box.3.	

You may be asked to install the .NET Framework at this 4.	
point. This software is required for Google SketchUp 
Pro.

Note: If you’re asked to reboot after installing the .NET Framework, please 
do so. To resume installing SketchUp, double-click on the SketchUp install 
file after your computer reboots.

Select the “I accept the terms of this license agreement” 5.	
button in the End User License Agreement if you agree 
to the terms.

Select the Next button to install SketchUp in the default 6.	
location.

Select the Install button if you’re satisfied with the 7.	
settings.

Select the Finish button when prompted.8.	

Launch Google SketchUp once before logging out of 9.	
the administrative user account.

Macintosh computers
Log in to the computer with a user account that has 1.	
administrator rights.

Double-click on the DMG install file that you 2.	
downloaded. This will mount an installer drive and 
launch a Finder window.

Double-click on the “.mpkg” file. This will launch the 3.	
installer window.

Select Continue in the Introduction section.4.	

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support 
http://earth.google.com/support 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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If you accept the Software License Agreement, select 5.	
the Continue button, then click Agree.

Select the destination for the installation and select 6.	
Continue.

Select the Install button. You may be prompted for 7.	
your administrator account password to authorize the 
installation.

When the installation completes, select the Close 8.	
button.

Learning to make models with  
Google SketchUp
The best way to get started with Google SketchUp is to see 
it in action. Many, many good training videos are available 
online for free; here’s where to find some of them:

Official SketchUp Video Tutorials

Go 2 School

Concept3D

Google SketchUp For Dummies

Another great source of information is the SketchUp  
Help Center:

Google SketchUp Help Center

Downloading and installing Google 
Earth
The procedure for downloading and installing Google 
Earth on your computer is very similar to the one for 
Google SketchUp. To get the latest version (5) of Google 
Earth, visit: http://earth.google.com

Learning to use Google Earth
The best way to get started with Google Earth is to visit 
the Introduction section of the online Google Earth User 
Guide. Of particular interest are the instructions for 
navigating around inside Google Earth:

Using a Mouse

Using the Navigation Controls

Building a SketchUp model with a 
precise geographic location
To give a SketchUp model a precise location in  
Google Earth:

Open Google SketchUp.1.	

Open Google Earth.2.	
Note: For best performance, make sure SketchUp is running before you 
start Google Earth; otherwise, SketchUp might run slowly.

In Google Earth, turn on 3D terrain. To do this, select 3.	
the “Terrain” check box in the Layers list on the left side 
of the screen.

Note: To ensure that the vertical position of SketchUp models you place 
in Google Earth is correct, set the Google Earth elevation exaggeration to 
“1”. In Google Earth, choose Tools > Options > 3DView > Terrain Quality 
and set “Elevation Exaggeration” = 1. (On a Mac, choose Google Earth › 
Preferences › 3DView › Terrain Quality). 

In Google Earth, use the navigation tools to frame a 4.	
top-down view of the location where you want to place 
your model.

Note: To get the best-possible image quality, make sure you’re zoomed in 
as far as you can be. Frame only as much land as you need to build your 
model.

To make sure you’re looking straight down at the ground, press “R” on your 
keyboard. Your camera will move to a top-down view, and your view will 
rotate so that North is at the top of your screen.

At this point, it’s a good idea to make sure the 3D Buildings layer (on the 
left side of your screen) is turned off.

In SketchUp, choose Tools › Google Earth › Get Current 5.	
View to import the section of terrain (and satellite 
imagery) that you framed in Google Earth in Step 3.  
A flat, black-and-white “snapshot” appears in the center 
of your SketchUp file.

Note: You can also use the Get Current View button to import a snapshot 
from Google Earth. The black-and-white Google Earth snapshot is used 
only for accurately positioning your model. It is not re-exported to Google 
Earth with the rest of your model.

In SketchUp, build a model on top of the Google  6.	
Earth snapshot you imported in Step 4.

Note: You can also import a Google Earth snapshot into a SketchUp file 
with an existing model. In this case, use the Move, Rotate and Scale tools to 
accurately position your existing model on the Google Earth snapshot.

You can also place a model from a separate SketchUp file into the file with 
the Google Earth snapshot.

In SketchUp, choose Tools > Google Earth > Toggle 7.	
Terrain to view the 3D version of your Google Earth 
snapshot. If the terrain in your snapshot is not flat, it 
appears as a 3D, sloped surface that reflects the 3D 
terrain in Google Earth.

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/training/videos.html 
www.youtube.com/4sketchupgo2school 
www.youtube.com/concept3Dmodeling 
www.youtube.com/aidanchopra 
http://sketchup.google.com/support 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://earth.google.com/userguide/v4
http://earth.google.com/userguide/v5/#mouse 
http://earth.google.com/userguide/v5/#navcontrols 
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Note: When you import a Google Earth snapshot, two versions are actually 
added to your SketchUp file. The first is a flat surface that is easier to 
work with as you build or laterally position your model. The second is a 3D 
surface that you use to adjust the vertical position of your model. You can 
switch between the two versions of the Google Earth snapshot by choosing 
Tools > Google Earth > Toggle Terrain.

You can also use the Toggle Terrain button to switch between versions of 
the Google Earth snapshot.

In SketchUp, use the Move tool to adjust your model’s 8.	
vertical position relative to the 3D Google Earth 
snapshot. Your model should not be floating above the 
terrain, nor should it be sunken too far into the ground.

Note: To “lock” the Move tool so that you can only move in the vertical 
(blue) direction, press either the Up Arrow or Down Arrow key on your 
keyboard.

If something you’re trying to move in the blue direction won’t move in 
that direction, it might be glued. To unglue it, right-click on it and choose 
Unglue.

If you’re unable to get your model to sit on the Google Earth snapshot 
without having it float or be sunken too far underground, you might 
consider adding material to the bottom of your model. The terrain in 
Google Earth is not 100% accurate, so some adjustment of models in 
SketchUp is necessary to make them appear correct when they’re viewed  
in Google Earth.

In SketchUp, choose Tools > Google Earth > Place 9.	
Model to export your model to Google Earth. Google 
Earth becomes your active application, and your model 
appears on the terrain in the location you specified using 
the Google Earth snapshot.

At this point, the model you’ve placed in Google Earth is 
visible only on your computer—no one else can see it.  
To share it with other people, you have at least two options:

You can save it as a Google Earth KMZ file that you can 
email or otherwise send directly to other people.

You can upload it to the Google 3D Warehouse, where 
anyone you specify can download it onto their computer. 
If you want your model to appear by default in the 3D 
Buildings layer in Google Earth (so that it’s automatically 
visible to everyone in the world), this is the approach you 
need to take.
Note: You can also use the Place Model button to export your model to 
Google Earth.

Uploading a model to the Google 3D 
Warehouse
The Google 3D Warehouse is a searchable, online 
repository of 3D models.

Anyone can upload a model to the 3D Warehouse.

When you upload a model, you can specify who gets to see 
it. Models can be unshared, shared with specific people, or 
shared with the whole world.

Models in the 3D Warehouse are either geographically 
located (meaning they have a precise location on the 
Earth), or non-geographically located (meaning they do 
not). You can geographically locate a model by using 
SketchUp in combination with Google Earth.

Google 3D Warehouse

To upload a SketchUp model to the 
Google 3D Warehouse:

In Google SketchUp, open the model you’d like to 1.	
upload to the 3D Warehouse.

Use SketchUp’s navigation tools (Orbit, Pan and Zoom) 2.	
to frame the view of your model that you would like to 
appear by default in the 3D Warehouse.

Choose File > 3D Warehouse > Share Model. A Google 3.	
Account “Sign in” page opens on your screen.

Note: If the “Upload your model to 3D Warehouse” page appears instead of 
the “Sign in” page, you (or someone else) is already signed-in to a Google 
Account. The name of the account appears at the top of the page. If you 
like, you can sign out of that account and sign in to a different one, then 
click the “Back” arrow in the upper-left corner to return to the Upload page.

Enter your Google Account username and password, 4.	
then Sign In. The “Sign in” page closes and the “Upload 
your model to 3D Warehouse” page opens.

Note: You need to have a Google Account to upload models to the 3D 
Warehouse. If you don’t have a Google Account, you can get one by 
selecting “Create an account now”.

Your Google Account login information is the same as your login 
information for any other Google product, including iGoogle, Gmail,  
Picasa Web Albums and Google Docs.

On the “Upload your model to 3D Warehouse” page, 5.	
enter the following information:

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/3dwarehouse/ 
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Title
Give your model a title that’s descriptive and meaningful.

Description
Models with thorough and well-written descriptions are 
much more popular than models with short or badly- 
written ones.

Tags
Tags are keywords or short phrases that describe your 
model. They make your models easier to find when 
someone is searching for something specific. Separate 
each tag with a comma (,) and try to anticipate what terms 
searchers might use to find models like yours.

If your model is geographically located, the “Upload” page 
includes these options:

Address
If your model is a building that has a street address, enter it. 
Your shelter probably doesn’t, though.

Google Earth Ready
A “Google Earth Ready” model is one that is correctly 
geographically located and is an accurate depiction of 
the building or other structure that currently exists in 
that location. Unless your shelter actually exists as a built 
structure in the real world, don’t check this box. 

If you like, you can enter the following optional information:

Web site (optional)
If there’s a web page that contains more information 
about your model, paste in its URL. Typically, URLs look 
something like this: http://www.google.com

Add a logo (optional)
If there’s a logo image you’d like to associate with your 
model, you can. You can either choose an image file from 
your computer or paste in a URL for an image on the Web.

Allow anyone to view this model and see it in  
search results
Deselecting this check box allows you to specify who (if 
anyone) gets to view and/or collaborate on your model.  
For this competition, you must leave this checkbox 
selected; if you deselect it, no one will be able to see your 
entry.

Show list of links for containing collections
Deselecting this check box hides the “Collections 
containing this model” area on your model’s Details page. 

You should choose this option if you don’t want visitors to 
see a list of collections that include your model.

Allow 3D Warehouse users to contact me about  
this model
Deselecting this check box hides the “Contact” button on 
your model’s Details page. You should choose this option 
if you don’t want to receive email from people about your 
model.

Select “Upload” to upload your model to the Google 6.	
3D Warehouse. Your model is uploaded and the 3D 
Warehouse Model Details page appears.

Select the Link button at the bottom of the page, then 7.	
copy the web address for your model. You’ll need it to 
fill out the entry form for this contest.

Finding your model on the Google 3D 
Warehouse after you’ve uploaded it
You can get to the Google 3D Warehouse in two ways:

by visiting http://sketchup.google.com/3dwarehouse from 
any Web browser (such as Firefox, Chrome, Safari or 
Internet Explorer). 

By choosing File > 3D Warehouse > Get Models from the 
menu bar inside SketchUp

To find all of the models you’ve 
uploaded to the 3D Warehouse:

Sign in (if you haven’t already) using the same Google 1.	
Account information you used to upload your model(s).

Select the My Models link at the top of the page to see 2.	
a list of the models you’ve uploaded.

Getting the web address for your 
model after you’ve uploaded it
To enter this competition, you’ll need the Web address for 
your model in the Google 3D Warehouse. This is a link 
directly to your model on the Web.

Find your model in the Google 3D Warehouse. For 1.	
help, see the instructions above.

Make sure you’re on the page for the model whose 2.	
address you want to find.

Select the Link button at the bottom of the page, then 3.	
copy the web address that appears in the box below the 
button. It should look something like this:

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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http://sketchup.google.com/3dwarehouse/details?mid=asdf;
lk4h35oig7aogoshgh
Note: To copy, highlight the text and choose Edit > Copy from the  
menu bar.

Exporting a JPEG image from Google 
SketchUp
To export a view of your model as a JPEG image:

Manipulate the view of your model so that it appears 1.	
as you would like it to appear in the exported image. 
SketchUp will export the model view as it’s currently 
displayed, including display style, shadows, and point  
of view.

Select File > Export > 2D Graphic from the menu bar. 2.	
The Export 2D Graphic dialog box appears.

Enter a file name for the exported file in the “File name” 3.	
(Microsoft Windows) or “Save As” (Mac OS X) field.

Select “JPEG” as the export type from the “Export type” 4.	
(Microsoft Windows) or ‘Format’ (Mac OS X) drop-
down list.

Note: Selecting the “Options” button brings up a list of export options.  
For images that you plan to submit for this competition, leave the “Use 
View Size” checkbox selected.

Then select the Export button.5.	

Exporting an animation (movie) from 
Google SketchUp
You can export movies of your models from Google 
SketchUp that you can view on your computer, send to 
other people, or upload to video sharing Web sites like 
YouTube.

Before you can export an animation from Google 
SketchUp, you need to set up Scenes in your model. 
Scenes are a little bit like different camera views. When it 
exports an animation, SketchUp moves its “camera” from 
Scene to Scene, creating a smooth transition between the 
different views that you set up.
Note: Keep in mind that in SketchUp’s animations, only the camera moves; 
it’s not possible to create animations wherein individual objects within the 
model move.

To create Scenes in your SketchUp model:
Manipulate the view of your model so that it appears as 1.	
you would like it to appear in the Scene you’re about the 
create.

Note: Scenes can save more than just the camera position in your model. 
They can also save other properties such as shadow position, display style 
and field of view.

Choose View > Animation > Add Scene. A new Scene is 2.	
created, and a corresponding Scene tab is added at the 
top of your modeling window.

Note: To update, rename or delete an existing Scene, right-click its Scene 
tab to bring up a context menu of options. You can also add, delete and 
otherwise manage the Scenes in your model by using the Scenes Manager 
dialog box, which appears when you choose Window > Scenes from the 
menu bar.

Repeat Steps 1 and 2 for each new Scene you want to 3.	
create.

With Scenes created, you can export an animation (movie) 
from your SketchUp model:

Choose Window > Model Info from the menu bar. 4.	
When the Model Info dialog box appears, select the 
Animation panel from the list on the left.

Enter settings for Scene Transition and Scene Delay, 5.	
then close the Model Info dialog box.

Scene Transition
This is the amount of time it takes for SketchUp to move 
between consecutive Scenes.

Scene Delay
This is the amount of time that SketchUp will pause on 
each Scene before moving on to the next.

Choose File > Export > Animation from the menu bar. 6.	
The Export Animation dialog box appears.

Enter a file name for the exported file in the ‘File name’ 7.	
(Microsoft Windows) or “Save As” (Mac OS X) field.

Select AVI (Windows) or Quicktime Movie (Mac OS 8.	
X) as the export type from the “Export type” drop- 
down list.

Click the Options button to open the Animation Export 9.	
Options dialog box.

Enter the following settings to export an animation 10.	
video which you can upload to YouTube:

Width and Height: 
1280 x 720

Frame Rate: 
30 frames/second

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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Anti-alias: 
Yes

Select the Codec button (Windows) or the Expert 11.	
button (Mac OS X) to open the Compression dialog 
box. Enter the following settings to export an animation 
video which you can upload to YouTube:

Codec (Windows): 
Indeo Video 5.10

Compression Type (Mac OS X): 
H.264

Key Frame Every: 
24 frames

Compression Quality (Windows): 
50

Quality (Mac OS X): 
Medium

Select OK to close the Compression dialog box, then 12.	
OK to close the Animation Export Options dialog box.

Select Export to create your animation video file.13.	

Uploading an exported SketchUp 
animation to YouTube
To upload your exported video to YouTube:

Make sure the video file you want to upload to YouTube 1.	
is no more than 10 minutes in length and less than 1GB 
in file size. If your video doesn’t fall within these limits, 
you’ll have to re-export a smaller or shorter video. Try 
re-exporting it using a smaller Frame Rate (20 fps is a 
good place to start).

Go to the YouTube Web site at www.youtube.com.2.	

Select the Upload button in the upper-right-hand corner 3.	
of any YouTube page.

Note: If you haven’t already, sign in to YouTube with either your Google 
Account (which you used to upload your model to the Google 3D 
Warehouse) or your YouTube account (if you have one).

Use the “Browse” button to browse for the video file 4.	
you’d like to upload to the site. Select the file you want 
to upload.

Select the “Upload Video” button to start the uploading 5.	
process.

As the video file is uploading, enter as much information 6.	
about your video as possible in the relevant fields 
(including Title, Description, Tags, and Category). 
You’re not required to provide specific information,  
but the more information you include, the easier it is for 
users to find your video.

Use the “Save changes” button to save the updates 7.	
you’ve made to the video file.

It can take from a couple minutes to an hour for your 8.	
video to upload to YouTube. If you’re receiving an 
error with your Upload, you might want to make sure 
you’re attempting to upload a file that’s recognized by 
YouTube. YouTube accepts video files from most digital 
cameras and camcorders, and cell phones in the .AVI, 
.MOV, .WMV, and .MPG file formats.

After your video is publicly available, copy the Video 9.	
URL (on the right side of the page). You’ll need it to fill 
out the entry form for this competition.

Competition Selection and prizes
The competition’s submission period runs from June 8 
through August 23. After the closing date—11 p.m. EST 
on August 23, 2009—students from the Frank Lloyd 
Wright School of Architecture will choose 10 finalists to 
be included in the People’s Prize voting, which will run 
from September 7 through October 10. At the same time, 
a panel of experts will convene in New York to review all 
shelter designs and select the winner of the Juried Prize. 
Two prizes—a People’s Prize and a Juried Prize—will be 
awarded. Winners of both prizes will be announced on 
the Guggenheim’s Web site and at the Guggenheim’s 
50th Anniversary Celebration on October 21, 2009 at the 
Guggenheim Museum, New York.

Jury of Experts
Aidan Chopra, Product Evangelist, Google SketchUp 
Aidan Chopra works at Google as the product evangelist 
for Google SketchUp, a 3-D modeling tool used by 
design professionals, engineers, and 3-D enthusiasts all 
over the world. He is the author of Google SketchUp For 
Dummies, which was published in 2009. Chopra holds an 
undergraduate degree from NSCAD University in Halifax, 
and a Master of Architecture degree from Rice University 
in Houston. At Google, his job is to be an advocate for  
the everyday communication of concepts, ideas, and  
places in 3D.

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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Martin Cox, Principal, Bade Stageberg Cox
Martin Cox is a principal of the New York firm Bade 
Stageberg Cox. The work of the practice has been 
widely published, and has won several awards including 
a 2009 New York AIA Honor Award for their proposal 
for the annual MoMA/P.S. 1 Young Architects Program, 
and a 2008 California AIA award for their Art Cave 
project. Previously, from 1996 until 2006, he was a senior 
associate at the firm Steven Holl Architects. Cox teaches 
design studio in the graduate program at Yale School of 
Architecture.

Neil M. Denari, Principal, Neil M. Denari Architects
Neil M. Denari is currently a professor in the Architecture 
and Urban Design Department at UCLA. He is the 
author of two bestselling books, Interrupted Projections 
and Gyroscopic Horizons. In 2002, he was given both the 
Richard Recchia Award and the Samuel F.B. Morse Medal 
for architecture from the National Academy of Design 
in New York for distinguished work in the field. In 2008, 
the American Academy of Arts & Letters awarded him 
the Academy Award for Architecture. Denari received his 
BA from University of Houston and a master’s degree in 
architecture from Harvard University. In 1988 Denari began 
Cor-Tex Architecture in Los Angeles, which later became 
Neil M. Denari Architects (NMDA), Inc.

Cathleen McGuigan, Contributor, Newsweek
Cathleen McGuigan is a contributor to Newsweek, where 
she writes about architecture, design and culture. Her 
articles have also appeared in numerous other publications 
including the New York Times Magazine, Smithsonian, 
Architectural Record, and Harper’s Bazaar. A graduate of 
Brown University, McGuigan was a recipient of the Loeb 
Fellowship at the Harvard Graduate School of Design. 
She is an adjunct professor at the Columbia School of 
Journalism, a member of the Forum for Urban Design, and 
serves on the board of the Skyscraper Museum in  
New York.

Victor Sidy, Dean of the Frank Lloyd Wright School of 
Architecture
Victor Sidy received his architectural training from the 
Frank Lloyd Wright School of Architecture after receiving 
the Flinn Foundation Scholarship and Robert C. Byrd 
Scholarship. He has worked with artists, architects, and 
planners in Russia, Germany, the Netherlands, and the 

United States and has taught students from elementary 
school to graduate school in a variety of architecture-
related fields. From 1996 to 1998 Sidy hosted a television 
series on architecture for EMG Satellite Television, and 
in May 1999 was the youngest member of Architecture 
Magazine’s feature “Young Americans.” He was named 
Dean of the Frank Lloyd Wright School of Architecture  
in 2005.

Lisa Strausfeld, Partner, Pentagram
Lisa Strausfeld has been a partner in Pentagram’s New York 
office since 2002. She and her team specialize in digital 
information projects that include the design of large-scale 
media installations, signage and exhibitions, software 
prototypes, user interfaces, and Web sites. Strausfeld 
has been a member of The Gallup Organization’s Senior 
Scientist program since 2006, was selected as a “Cutting 
Edge Designers” in 2007 by BusinessWeek, and was named 
a Finalist in the Interaction Design category of the 2009 
National Design Awards. She studied art history and 
computer science at Brown University and earned master’s 
degrees in architecture from Harvard University and in 
media arts and sciences from M.I.T.

David van der Leer, Assistant Curator of Architecture 
and Design, Solomon R. Guggenheim Museum
David van der Leer joined the Guggenheim in October 
2008 and is co-curator of the current exhibition Frank 
Lloyd Wright: From Within Outward. Prior to the 
Guggenheim, he held editorial and curatorial positions at 
010 Publishers in Rotterdam; the Office for Metropolitan 
Architecture (OMA), in Rotterdam, under Rem Koolhaas; 
and Steven Holl Architects in New York. Van der Leer 
has lectured internationally on architectural theory and 
is a regular contributor to publications such as Domus, 
Mark, The Architect’s Newspaper, Azure, and PIN-UP. He 
received his master’s in Urban and Architectural Theory 
from the Department of Art & Cultural Sciences at 
Erasmus University Rotterdam, the Netherlands. 

Overview of Prizes
People’s Prize
Trip for two to New York City (includes airfare and hotel 
accommodations for two nights)

Behind-the-scenes tour of the Guggenheim Museum and 
the Google Offices

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form


page 10  |  guggenheim.org/shelter

Free admission to other NYC museums

Google SketchUp Pro license (USD$495 value)

Juried Prize
$1000 cash prize

Trip for two to New York City (includes airfare and hotel 
accommodations for two nights)

Behind-the-scenes tour of the Guggenheim Museum and 
the Google Offices

Free admission to other NYC museums

Google SketchUp Pro license (USD$495 value)
Note: In the event that the same shelter design is chosen by those voting  
for the People’s Prize and by the experts determining the winner of the 
Juried Prize, the People’s Prize will be awarded to the entrant who receives 
the second highest number of votes for the People’s Prize.

See official rules (pg. 12) for details.

frequently asked questions
General Questions about the competition
Q: How do I enter?
A: Complete the submission form and enter all required 
information indicated with an asterisk below (unmarked 
items are optional). All images and text submitted as part 
of the entry may be used for marketing and promotional 
purposes and will not be returned. Entries must be 
submitted during the submission period (June 8–August 
23, 2009) to be considered.

First Name*
Last Name*
E-mail address*
City where you reside*
Country where you reside*
Age* (Must be 13 years or older as of June 8, 2009)

Shelter Title* (Limited to 40 characters)

Shelter Description* (Limited to 70 words)

Google 3D Warehouse Model Link* 
Country where your shelter is located*
Upload image of your shelter*
Upload 2nd image of your shelter

Upload 3rd image of your shelter 
Upload 4th image of your shelter
YouTube Video URL 
Note: All entries must be in English. You must read and accept the official 
rules prior to submitting your form.

Q: Why doesn’t my shelter appear on the Guggenheim 
Web site after I submit it?
A: It may take up to 72 hours for your shelter to appear 
on the Guggenheim Web site. You will receive an e-mail 
notification on whether your submission has been accepted 
or rejected if it does not meet competition specifications.

Q: How does the judging work?
A. There are two competition prizes: a Juried Prize and a 
People’s Prize. Qualified entrants are eligible to win only 
one prize, either the Juried Prize or the People’s Prize.

For the Juried Prize, a panel of independent experts will 
select a Juried Prize winner from all qualified entries.

For the People’s Prize, a panel of students currently enrolled 
at the Frank Lloyd Wright School of Architecture will select 
ten finalists from all qualified entries. The People’s Prize 
winner will then be selected from this pool of finalists by 
public vote via the competition Web site. Voting will be 
open from 9:00 a.m. EST September 7, 2009 through  
11 p.m. EST on October 10, 2009. Visit the  
Jury and Prizes page for more information.

Q: What are the judges looking for?
A. Qualified entries will be judged on a variety of qualities, 
including:

The relationship of the shelter to the built or natural 
environment around it. How does the architecture of your 
shelter relate to physical location you have chosen for it? 
How is your shelter placed on the site? In what ways does 
your shelter take into account the site’s weather?

Innovative design. How does your shelter organize space? 
How does the design of your shelter provide space to live 
and work? Both practical and fanciful ideas are welcome. 
The jury will not take into account whether a shelter could 
physically be built in real life.

Thoughtful use of materials. Why did you choose the 
materials that you used? How do the materials enhance the 
design of your shelters?

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/jury-and-prizes 
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Adherence to the project specs. The interior/sheltered space 
can be no larger than 100 square feet, and entire shelter
no taller than 12 feet high. The structure should not include 
water pipes, gas lines, or electrical wiring.

Quality of the SketchUp model. Well-built models that 
visually represent your design ideas will catch the eye of  
the jury.

Your written description of your shelter will help the jury 
(as well as visitors to the site) to understand your thought 
process and your design. Take this opportunity to explain 
your ideas and decisions, so that viewers will know that your 
choices were made purposefully and for specific reasons. 
You also have the ability to upload up to 4 still images and 
1 animation of your shelter. Although only one still image 
is required, the additional views can be helpful in giving a 
sense of the space in and around your shelter.

Q: How will the winners be announced?
A: The winners will be announced on the Guggenheim’s 
Web site and at the Guggenheim Museum’s 50th 
Anniversary Celebration on Oct. 21, 2009. Winners will also 
be announced on the same day on the Google SketchUp 
blog, Lat Long, and other official Google blogs.

Q. Can I submit more than one shelter?
A: Yes.

Q: How old do I have to be to enter?
A: You must be 13 years of age or older on or before  
June 8, 2009.

Q: May I work collaboratively with other people?
A: Yes, you may seek assistance from others, but there  
can only be one official entrant and one winner per prize.

Q: How many times can I vote for the People’s Prize 
winner?
A: You may vote only once.

Q: What are the prizes?
A: The Juried Prize winner and one guest will be flown to 
New York City (economy class) for a behind-the-scenes 
tour of the Solomon R. Guggenheim Museum and the 
Google Offices. The Juried Prize also includes two nights 
accommodation for two, complimentary admission to 
selected New York City museums, a Google SketchUp Pro 
license (USD$495 value), and a USD$1000 cash award.

The People’s Prize winner and one guest will be flown to 
New York City (economy class) for a behind-the-scenes 
tour of the Solomon R. Guggenheim Museum and the 
Google Offices. The People’s Prize also includes two nights 
accommodation for two, complimentary admission to 
selected New York City museums and a Google SketchUp 
Pro license (USD$495 value).

Q: If I have other questions, who do I ask?
A. Feel free to visit our Design It: Shelter Competition 
Google Group, an online community where you can share 
your experiences with other participants and get answers to 
your questions. If you need additional help, you can e-mail 
us at foundation@guggenheim.org.

Questions about the tools
Q: Do I need the Pro versions of SketchUp or Earth to 
model for this competition?
A: No. The free versions of Google SketchUp and Google 
Earth will work just fine.

Q: What is the difference between SketchUp and 
SketchUp Pro? Will I be able to make a better model if I 
buy the Pro version?
A: You don’t need to have the Pro version of SketchUp 
in order to enter this competition. The model-making 
features of both the Free and Pro versions are very similar, 
and both can upload files to the Google 3D Warehouse 
and create models which can be viewed in Google Earth. 
Read this article to learn more about the differences 
between the two versions of SketchUp. 

Q: How do I submit my models?
A: Models must be submitted via the submission form. 
Please visit the How to Enter page for competition 
guidelines.

Q: My model appears in the wrong city when I place it in 
Google Earth. How do I fix this?
A: If you create a model without first getting the current 
view from Google Earth and then place your model in 
Google Earth, the model uses the coordinates of the 
default location. Please read this article to find out how to 
resolve this issue.

Q: How do I learn to use Google SketchUp?
A: See the Google SketchUp Tutorial page for instructions 
and resources.  Read this article for a list of ways to get up 
and running quickly. 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://groups.google.com/group/DesignItCompetition?pli=1
http://groups.google.com/group/DesignItCompetition?pli=1
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=36201
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/how-to-enter 
http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/sketchup-tutorial
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=36211
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Q: Is there a list of keyboard command short-cuts for 
SketchUp?
A: Yes. Keyboard command short-cuts for SketchUp are 
available as a PDF download on this page. 

Q: What are the design constraints for my shelter?
A: You can build your shelter anywhere on Earth: from city 
to desert, hill to valley. You cannot remove any existing 
buildings, but you can add on to existing structures. Keep 
your shelter small—it can be no larger than 100 square feet 
(9.3 square meters), and entire shelter no taller than 12 feet 
(3.6 meters). Your shelter must offer protection from the 
elements and provide a space for one person to study and 
sleep. Keep it simple—no water, gas or electricity allowed.

Q: What types of file type and size are required for the 
still images?
A: JPEGs at a minimum of 235 pixels wide but no larger 
than 720 pixels wide at 72 dpi.

Q: If I build a physical shelter in real life, can I submit 
photos of that in addition to the SketchUp model?
A: Yes, you may use one (or more) of the images in the 
submission form to include shots of the physical structure.

Q: Do I have to use Google SketchUp to model my 
shelter?
A: You can use any 3-D modeling software you prefer to 
design your shelter, but you must upload your model to 
the Google 3D Warehouse, and this can only be done 
from inside Google SketchUp. If you decide to use another 
tool to do your modeling, know that SketchUp imports 
3-D model data in DXF, DWG and 3DS format. Read 
this article for more information about importing data into 
SketchUp.

Q: I forgot to tell SketchUp where to place my model on 
Google Earth. Now that my model is complete, how can 
I have it appear in the location on Google Earth?
A: You can import a Google Earth terrain “snapshot” into 
your SketchUp file at any time, then position your model 
in the right place. Doing so gives your model a geographic 
location. Read this article for more information. 

Q: Can I make changes to my model after I’ve 
submitted it?
A: No, you may not make changes to your model after 
submitting it.

Q: I was able to make some changes to my model in the 
Google SketchUp 3D Warehouse after I submitted, but 
I do not see the updated changes on the Guggenheim 
competition site.
A: Once you submitted your model to the competition, 
you are no longer permitted to make changes.

official rules
No purchase necessary to enter or win.

The following are the official rules for the Guggenheim 
Museum and Google® SketchUp Design It Shelter 
Competition (the “Competition”):

Organizer: The Competition is organized by The 1.	
Solomon R. Guggenheim Foundation, located at 
345 Hudson Street, Floor 12, New York, NY 10013 
(“Organizer”).

Binding Agreement: In order to enter the Competition, 2.	
each entrant (“you”) must agree to these Official Rules, 
which consist of the terms and conditions on this page 
and the Entry Form made available on the Guggenheim 
Foundation Web site at http://www. guggenheim.org/
new-york/education/sackler-center/design-it-shelter/
official-rules. If you are a minor, you must obtain the 
permission of a parent and/or legal guardian and your 
parent and/or legal guardian must also agree to these 
Rules on their and your behalf before you can enter 
this Competition. Therefore, please read these Rules 
carefully prior to entry to ensure that you understand 
and agree. You agree that submission of an entry in 
the Competition constitutes agreement to these Rules.  
You may not submit an entry to the Competition and 
you are not eligible to receive the prizes described in 
these Rules unless you agree to these Rules.  These 
Rules form a binding legal agreement between you and 
Organizer with respect to the Competition. You must 
have access to the Internet and a valid e-mail address in 
order to enter the Competition.

Eligibility: The Competition is open to entrants 13 3.	
years of age and older. Anyone between the ages of 13 
to 17 must obtain the permission of a  parent or legal 
guardian prior to entering, and the parent or guardian 
must  consent to be bound—on their child’s and their 
own behalf—to these Official Rules. The Competition 
is subject to all applicable federal, state and local laws 
and regulations, and is void where prohibited by law. 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
http://sketchup.google.com/support/bin/answer.py?hl=en&answer=116693 
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Employees of Organizer, employees of Google Inc., 
and students and employees of the Frank Lloyd Wright 
School of Architecture—as well as their immediate 
families (spouse, parent, sibling, child, and spouse of any 
of the foregoing) and those living in their immediate 
households, whether or not related—are not eligible to 
enter the Competition or to win a prize. 

Entry Period: The Competition entry period begins 4.	
June 8, 2009 at 9 am EST and ends on August 23, 2009 
at 5 pm EST (the “Entry Period”).

Competition Details: Organizer invites designers from 5.	
around the world—both amateur and professional—to 
submit their 3D designs for an original shelter that 
responds to a unique location anywhere on Earth.  
Entrants share ideas on the Guggenheim Foundation’s 
Web site by modeling the shelter using Google 
SketchUp or another 3D modeling program, and 
placing the model on a specific location in Google Earth 
and in the Google 3D Warehouse. Location:  
You can build your shelter anywhere on earth: from city, 
to desert, from the hills to a valley. You cannot remove 
any existing buildings, but you can add on to existing 
structures. Size: Keep your shelter small—no larger than 
100 square feet, and entire shelter no taller than 12 feet. 
Amenities: Your shelter must offer protection from the 
elements and provide a space for one person to study and 
sleep. Keep it simple—no water, gas or electricity allowed.

When designing a shelter, you are encouraged to 
consider Frank Lloyd Wright’s interest in the connection 
between architecture and location, i.e., how does 
your shelter respond to the specific natural and built 
environments that surround it?

How to Enter: Complete the entry form and enter 6.	
all required information as indicated with an asterisk 
below (unmarked items are optional). Entries must be 
submitted here: http://www.guggenheim.org/new-york/
education/sackler-center/design-it-shelter/designit-
competition-entry-form. All images and text submitted 
as part of the entry may be used by Organizer for 
marketing and promotional purposes and will not be 
returned. Entries must be submitted during the Entry 
Period to be considered.

First Name*
Last Name*
E-mail address*
City where you reside*
Country where you reside*
Age* (Must be 13 years or older as of June 8, 2009)
Shelter Title* (Limited to 40 characters)
Shelter Description* (Limited to 70 words)
Google 3D Warehouse Model Link* 
Country where your shelter is located*
Upload image of your shelter* 
Upload 3rd image of your shelter (same as above)
Upload 4th image of your shelter (same as above)
YouTube Video URL 
All entries must be in English. In order to be eligible for 
a prize, your entry must be uploaded into the Google 
3D Warehouse. To upload your model to the 3D 
Warehouse you must create a Google Account. To sign 
up for a Google Account, visit http://www.google.com/
accounts. Organizer accepts no responsibility for lost 
or delayed submissions. The submission of an entry is 
your sole responsibility. Automated entries (including, 
but not limited to, entries submitted using any bot, 
script, macro or contest service), copies, third-party 
entries, facsimiles and/or mechanical reproductions are 
not permitted and will be disqualified. Each entrant may 
submit as many entries as they wish, one model shelter 
per entry.
Ownership Rights in Submissions; Originality; 7.	
License Grant: By submitting a shelter design in the 
Competition (the “Submission”), you represent and 
warrant that (1) the Submission (which includes the 
models, images, video, and text submitted with the 
shelter design) is your original work and you are the 
sole and exclusive owner and rights holder of the 
Submission; (2) you have not entered into or become 
subject to any contract, agreement or understanding 
that conflicts with your ability to enter into this legally 
binding agreement and convey the rights set forth 
herein; and (3) the Submission shall not infringe 
any third party proprietary, intellectual property or 
other rights, including, without limitation, copyright, 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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trademark, patent, trade secret or confidentiality 
obligation. Your entry must not have won a prize in any 
other competition or have been previously published  
or sold.

By submitting a Submission, you grant to Organizer 
and Google Inc., their affiliates, and their respective 
successors and assigns, a non-exclusive, unlimited, 
worldwide, perpetual, royalty-free license to publish, 
reproduce, display, transmit, distribute, adapt, make 
derivative works of, and otherwise use your Submission, 
in any media now known or not yet existing, including 
but not limited to the Guggenheim.org Web site and 
other Guggenheim- and Google-sponsored web pages 
for any and all purposes. You hereby acknowledge that 
you shall not be entitled to any compensation for any 
use of your Submission by Organizer.

Winner Selection: There are two Competition prizes: a 8.	
Juried Prize and a People’s Prize. Each qualified entrant 
is only eligible to win either the Juried Prize or the 
People’s Prize

JURIED PRIZE: A panel of independent experts invited 
by Organizer will select a Juried Prize winner from all 
qualified entries

PEOPLE’S PRIZE: A panel of students currently 
enrolled at the Frank Lloyd Wright School of 
Architecture will select ten finalists for the People’s Prize 
from all qualified entries.  The winner will be selected by 
public vote via the Web site.  Voting will be open from 
9:00 a.m. EST September 7, 2009 through 11 p.m. EST 
on October 10, 2009

Qualified entries will be judged on a variety of qualities, 
including:

The relationship of the shelter to the built or natural 
environment around it. How does the architecture of 
your shelter relate to physical location you have chosen 
for it? How is your shelter placed on the site? In what 
ways does your shelter take into account the site’s 
weather?

Innovative design. How does your shelter organize 
space? How does the design of your shelter provide 
space to live and work? Both practical and fanciful ideas 
are welcome. The jury will not take into account whether 
a shelter could physically be built in real life. 

Thoughtful use of materials. Why did you choose the 
materials that you used? How do the materials enhance 
the design of your shelters.

Adherence to the project specs. Your shelter can be no 
larger than 100 square feet, and entire shelter no taller than
12 feet high. The structure should not include water pipes, 
gas lines, or electrical wiring.

Quality of the SketchUp model. Well-built models that 
visually represent your design ideas will catch the eye of  
the jury.

Your written description of your shelter will help the 
jury (as well as visitors to the Competition Web site) 
understand your thought process and your design. Take 
this opportunity to explain your ideas and decisions, 
so that viewers will know that your choices were made 
purposefully and for specific reasons. You also have the 
ability to upload up to four (4) still images and one (1) 
animation of your shelter. Although only one (1) still 
image is required, the additional views may be helpful in 
giving a sense of the space in and around your shelter.

The decisions of Organizer and the judges in 
selecting the winners and in all matters relating to 
the Competition are final and binding. The winning 
shelters and identity of the winners will be announced 
on Guggenheim.org and at the Guggenheim Museum’s 
50th anniversary celebration on October 21, 2009. 
The winners will be notified by email and in writing by 
certified mail no later than October 15, 2009.

Prizes:9.	

JURIED PRIZE: On a date to be determined by 
Organizer, the Juried Prize winner and one guest 
will be flown to New York City (economy class) for a 
behind-the-scenes tour of the Solomon R. Guggenheim 
Museum and the Google Inc. offices. The Juried Prize 
also includes two nights’ accommodation for two, 
complimentary admission for two to selected New York 
City museums, Google SketchUp Pro license (USD 
$495 value), and a USD $1000 cash award.

PEOPLE’S PRIZE: On a date to be determined by 
Organizer, the People’s Prize winner and one guest 
will be flown to New York City (economy class) for a 
behind-the-scenes tour of the Solomon R. Guggenheim 
Museum and the Google Inc. offices. The People’s 
Prize also includes two nights’ accommodation for two, 

http://www.guggenheim.org/new-york/education/sackler-center/design-it-shelter/designit-competition-entry-form
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complimentary admission for two to selected New York 
City museums and a Google SketchUp Pro license 
(USD $495 value.

If the winner of either the People’s Prize or the Juried 
Prize chooses not to accept the prize, an alternate 
winner will be chosen. All federal, state, and local taxes 
on the value of the prize are the sole responsibility 
of the winner. A 1099 tax statement will be filed with 
the IRS for each winner and each winner may be 
required to sign and return to Organizer a W-9 form, 
an Affidavit of Eligibility, a Liability/Publicity Release, 
and/or a Parental/Guardian Consent Form. Failure 
to do so within the applicable time period may result 
in disqualification and forfeiture of his or her prize. 
Return of any prize/prize notification may result in 
disqualification and selection of an alternate winner.  
Any potential winner who cannot be contacted within 
fifteen (15) days of attempted first notification may 
result in disqualification and forfeiture of his or her prize.

All minors traveling to New York City must be 
accompanied by one parent or legal guardian. 
Airfare and hotel accommodations will be arranged 
at Organizer’s discretion. Winners are responsible for 
transport from their home to and from their airport 
and any other incidentals or expenses. There is no cash 
alternative and the prizes must be taken as offered. 

Right to Use Name, Likeness, and Other Identifying 10.	
Information: By submitting a Submission, you grant to 
Organizer and Google Inc., their affiliates and their 
respective successors and assigns, the right, except 
where prohibited by law, to use your name, likeness, city 
and state, biographical information, and Submission 
materials for all purposes, including, but not limited 
to, press and media communications, without further 
compensation to you.  You also agree to participate 
in any media or promotional activity regarding the 
Competition. If you are a winner, you agree that 
Organizer and Google Inc. may use your name and 
likeness to administer and promote the Competition 
and to conduct media interviews and promotional 
events, and you hereby explicitly waive your rights of 
privacy and publicity under applicable law.

Privacy:  By participating in this Competition, you agree 11.	
that Organizer can collect your personal information, 
and that if Organizer cannot collect the required 
data, you may not be eligible to participate in the 
Competition.  Any personal information collected 
during the course of the Competition by Organizer will 
only be used for administering this Competition and 
for other purposes as outlined in these Official Rules, 
and will be subject to the Organizer’s and Google Inc.’s 
respective Privacy Policies located at  
http://www.guggenheim.org/privacy-policy/ and  
http://www.google.com/intl/en/privacy.html. You will 
have the right to access, review, rectify or cancel any 
personal data held by Organizer or Google Inc. by 
writing to Organizer or Google Inc. at the addresses 
specified in the above-mentioned Web site address 
listed above. If you do not want your information used in 
this manner, do not enter this Competition.

General Conditions: This Competition is governed 12.	
by the laws of the State of New York, United States.  
All federal, state and local laws and regulations apply.  
By participating in this Competition, you agree to be 
bound by the terms of these Official Rules, which will 
be posted on the Competition Web site at: http://
www.guggenheim.org/new-york/education/sackler-
center/design-it-shelter/official-rules throughout the 
Entry Period, and by the decisions of Organizer and 
the judges, which are final and binding on all matters 
pertaining to this Competition.

By participating in this Competition, you agree to be 
bound by the terms and conditions of the  
Guggenheim Foundation and Google, including any 
specific terms of use that govern Google SketchUp, 
Google 3D Warehouse and Google Earth, which are 
Google products.  Use of any Google products and 
related programs are neither hosted, managed nor 
operated by the Guggenheim Foundation.

Organizer reserves the right, in its sole discretion, to 
disqualify any entrant found to be (1) tampering or 
attempting to tamper with the entry process or the 
operation of the Competition; (2) violating the Official 
Rules; (3) violating the terms of service, conditions 
of use or general rules or guidelines of any Organizer 
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or Google Inc. property or service; or (4) acting in 
an unsportsmanlike or disruptive manner, or with the 
intent to annoy, abuse, threaten or harass any other 
person.  Any false information provided within the 
context of the Competition by any entrant concerning 
identity, postal address, or ownership of rights in the 
Submission, and/or non-compliance with Official Rules 
may result in the immediate elimination of the entrant 
from the Competition. Organizer further reserves 
the right to disqualify any entry that it believes, in its 
sole discretion, infringes or violates the rights of any 
third party or otherwise does not comply with the 
Official Rules.  CAUTION:  ANY ATTEMPT BY AN 
ENTRANT OR ANY OTHER INDIVIDUAL TO 
DELIBERATELY DAMAGE ANY WEB SITE OR 
UNDERMINE THE LEGITIMATE OPERATION OF 
THE COMPETITION MAY BE A VIOLATION OF 
CRIMINAL AND CIVIL LAWS.  SHOULD SUCH 
AN ATTEMPT BE MADE, ORGANIZER RESERVES 
THE RIGHT TO SEEK DAMAGES FROM ANY 
SUCH PERSON TO THE FULLEST EXTENT 
PERMITTED BY LAW.

Organizer, its affiliates, and their respective officers, 
directors, trustees, employees, agents, successors and 
assigns (collectively, the “Released Parties”) are not 
responsible for electronic transmission errors resulting 
in omission, interruption, deletion, defect or delay in 
operations or transmission.  Released Parties are not 
responsible for theft or destruction or unauthorized 
access to or alterations of Competition materials, or for 
technical, network, telephone equipment, electronic, 
computer, hardware or software malfunctions or 
limitations of any kind.  Released Parties are not 
responsible for inaccurate transmissions of or failure to 
display Competition materials as a result of technical 
problems or traffic congestion on the Internet or at any 
website or any combination thereof.  If for any reason 
the Internet portion of the Competition is not capable 
of running as planned, including infection by computer 
virus, bugs, tampering, unauthorized intervention, fraud, 
technical failures, or any other causes which corrupt or 
affect the administration, security, fairness, integrity, or 
proper conduct of this Competition, Released Parties 
reserve the right, in their sole discretion, to cancel, 
terminate, modify or suspend the Competition.

No Recourse to Judicial or Other Procedures: To the 13.	
extent permitted by law, the rights to litigate, to seek 
injunctive relief or to any other recourse to judicial 
or any other procedure in case of disputes or claims 
resulting from or in connection with this Competition 
are hereby excluded, and you expressly waive any and 
all such rights.

LIMITATIONS OF LIABILITY; INDEMNIFICATION: 14.	
TO THE MAXIMUM EXTENT PERMITTED BY 
LAW, YOU INDEMNIFY AND HOLD HARMLESS 
THE RELEASED PARTIES FROM AND AGAINST 
ANY LIABILITY, CLAIMS, DEMANDS, LOSSES, 
DAMAGES, COSTS AND EXPENSES RESULTING 
FROM, RELATED OR INCIDENTAL TO (1) ANY 
ACT, OMISSION, DEFAULT OR BREACH BY 
YOU OF THE RULES OR ANY WARRANTY 
BY YOU SET FORTH HEREIN; AND (2) YOUR 
PARTICIPATION IN THE COMPETITION AND/
OR YOUR USE OR ACCEPTANCE OF ANY PRIZE 
WON.

Severability: If any provision(s) of these Official Rules 15.	
are held to be invalid or unenforceable, all remaining 
provisions hereof will remain in full force and effect.

Entire Agreement: This binding agreement is the entire 16.	
understanding between you and Organizer concerning 
the subject matter addressed herein and supersedes 
and replaces any previous understandings between the 
parties concerning the subject matter addressed in this 
binding agreement. 
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